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PROPIETARY NOTICE
This MCID™ Basic software and all associated documentation (“MCID Basic”) constitute valuable assets
of, and are proprietary to, Imaging Research Inc. (“Imaging Research”) and are protected as such under
both the law of trade secret and copyright.
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Introduction
This document is a supplement to the MCID™ Basic online Reference Manual. It describes 
how use MCID Basic to quantify rates of local cerebral glucose utilization (LCGU) in tissue 
sections that have been exposed to autoradiographic film. It presumes that standard 
experimental procedures have been followed.
LCGU can be calculated with Sokoloff’s (Sokoloff et al., 1977) original operational equation 
(Equation 1) or with the Savaki (Savaki et al., 1980) modification (Equation 2). The Savaki 
equation should be used when plasma glucose concentrations vary considerably during the 
experiment (within a range of about 70 - 250 mg%) especially when the animal becomes 
progressively hyperglycemic. Keep in mind that the lumped constant changes, increasing in 
hypoglycemia and decreasing in hyperglycemia (Schuier et al., 1990; Suda et al., 1990).

Equation 1: Sokoloff’s original operational equation for LCGU.

  µmol/100g/min

Equation 2: Modified operational equation for LCGU.

Ri is the rate of glucose utilization (µmol/100g/min.). T is the time at the termination of the 
experimental period. Ci* is the total [14C] concentration in a single homogeneous tissue of 
the brain. Cp* and Cp represent the concentrations of [14C]deoxyglucose and glucose in the 
arterial plasma. λ is the ratio of the distribution space of deoxyglucose in the tissue to that of 
glucose. Φ is the fraction of glucose which, once phosphorylated, continues down the 
glycolytic pathway. Km*, Vm*, and Km, Vm, represent the Michaelis-Menten kinetic 
constants of hexokinase for deoxyglucose and glucose, respectively. The six constants 
collectively constitute the lumped constant.

Basic Procedure
The basic procedure for quantifying rates of glucose utilization in autoradiographic images is 
as follows:

1. Create an LCGU Accessory file for every animal used in the experiment. An 
accessory file contains data obtained from blood samples collected over the 
course of the experiment.
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2  Glucose Utilization MCID Basic 7.0
2. Adjust camera magnification and focus.
3. Establish a Flat Field Correction to correct for uneven illumination.
4. Establish an LCGU calibration for the first animal used in the experiment. The 

calibration is based on accessory file data and the values of the [14C] 
concentration standards.

5. Sample any/all specimens associated with the LCGU calibration (i.e., same 
animal, same film). 

6. Repeat Steps 4-5 for all remaining animals. Re-calibration is necessary whenever 
you change animals and/or films.

7. Summarize and save the data.

Step 1: Creating Accessory Files
Accessory file data are necessary to solve the operational equations for determining rates of 
local cerebral glucose utilization. The file contains data obtained from blood samples 
collected over the course of an experiment (LSC counts and glucose concentrations), and are 
used to calculate various parameters and integrals that are contained in the operational 
equation. A separate file must be created for every animal that is used in the experiment.
To create an LCGU accessory file, go to the Calibration operational window:

Open the Calibrations menu and select Edit accessory file > Blood data: LCGU (Figure 1). 
An LCGU dialog box is displayed.

Figure 1: The Calibrations > Edit accessory file menu option is used to create standard 
plasma data files for local cerebral glucose utilization (LCGU).

In the LCGU dialog box, enter the Species, sample Volume (µl), sample Times (minutes), 
LSC (dpm) values, and Plasma Glucose (mg%) values. Use the <Tab> key to move the 
cursor laterally within the table. The first LSC value must be a time 0 baseline count 
(Figure 2).
Imaging Research Inc. 03-MW-0117
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Figure 2: A typical accessory file used for LCGU analysis.

If any blanks appear in the glucose column, MCID Basic interpolates the missing values 
when it solves the operational equation. If the final time has no LSC and glucose value, it is 
assumed to be a kill time and values are extrapolated. When you have entered all of the 
necessary data, use the File menu within the dialog box to save the file. MCID Basic will 
automatically attach a *.cgu extension to the specified filename.

Step 2: Adjusting Magnification and Focus
Magnification is controlled by moving the camera up or down. Place a sheet of film on the 
light box and adjust the camera height while digitizing. With a 55mm lens, you should be 
able move the camera close enough so that a coronal rat brain section will almost fill the 
entire field of view. If the camera is too close to the specimen, you will not be able generate a 
clearly focused image.
If higher magnification is required (e.g., for mouse brain or other small tissue sections), use 
extension tubes. Extension tubes are little barrels that connect between the lens and the F-C 
adapter. They function like a bellows to increase magnification of the lens. Various sizes of 
extension tube give different magnification factors. For example, coronal section of spinal 
cord can be made to fill the screen when all three tubes are used.

Step 3: Establishing a Flat Field Correction
Camera images typically exhibit some intensity variation over the field of view due to 
uneven illumination. This “shading error” requires correction to less than 1% if accurate 
densitometry is to be performed. The Flat Field Correction compensates for shading error.

TO ESTABLISH A FLAT FIELD CORRECTION:
1. Remove the film from the field of view.
2. Select a pseudocolor look-up table (i.e., SPECT2.VIS).
3. Adjust the illumination intensity on the light box so that a blank field of view 

appears bluish-pink. Be sure to use a true blank field, not film background!
03-MW-0117 Imaging Research Inc.
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4. Ctrl-click on the Digitize icon and select Flat Field Correction from the list of 
Input Device Operations. If the operation is not present, click the [Customize] 
button to add it to the list.

5. A Flat Field Correction dialog box will appear (Figure 3). An [Acquire] and 
[Clear] button are displayed at the bottom of the dialog box, but only one of them 
will be active. If the [Clear] button is active, it means that a flat field correction is 
already in effect. Press [Clear] to remove it.

6. Select Digitize as the correction source and Pixel by pixel as the correction 
method.

7. The Frame average option will reduce the contribution of random electronic 
noise to the shading error. Three or four will usually do, unless you disable the 
Smoothing and Median filters (see below).

8. By default, a Smoothing and Median filter is applied to the shading error 
reference image (i.e., the blank field image) to reduce spatial variation and 
improve the signal-to-noise ratio. If you choose to disable these filters, be sure to 
use the Frame Averaging option when establishing the flat field correction, and 
increase the number of frames to 16 or more.

9. Press [Acquire] to establish a flat field correction. 
10. MCID Basic scans the blank field and determines how much each pixel deviates 

from the mean gray level value. Subsequent images are automatically corrected 
for uneven illumination, based on this error pattern.

11. Click [OK] to exit the dialog box.
Please note, the image that you see after you exit the dialog box is not a corrected image. The 
Flat Field Correction is not applied until the next time you digitize. If you wish to see the 
effects of the correction, digitize the same blank field again. The image will ‘even out’ as 
soon as digitization is terminated.
Once established, the flat field correction becomes part of the camera’s default configuration. 
Unless disabled or modified, MCID Basic will apply the same correction each time the 
particular camera is used, even if you have exited and re-started MCID Basic. As such, you 
should establish a new Flat Field Correction at the beginning of each analysis session.
One should also re-establish a Flat Field Correction whenever there is a change in ambient 
lighting, camera position, focus, camera gain and offset, light box position, or any other 
major factor that might affect the illumination pattern. Small changes in illumination level do 
not usually need a new correction, however, providing that optical system components are 
not moved relative to each other.
To remove or modify the current flat field correction, click the [Clear] button on the Flat 
Field Correction dialog box. Press [Acquire] to establish a new one.
Imaging Research Inc. 03-MW-0117
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Figure 3: The Flat Field Correction dialog box.

Step 4: Establishing an LCGU Calibration
The goal of an LCGU calibration is to construct a standard curve that relates optical density 
(ROD) to rates of glucose utilization (µmol/100g/min). The calibration is calculated from i) 
data contained in a single accessory file; ii) the nCi/g values of the [14C] standards, and iii) 
the ROD values of the [14C] standards when they have been exposed to film. A set of [14C] 
standards should be present of every sheet of film. A separate LCGU calibration must 
consequently be established for each animal and each sheet of film.
To create an LCGU calibration, go to the Calibration operation window and select 
Calibrations > Density. Change the density unit to LCGU. A dialog box now appears 
(Figure 4), asking you to select an accessory file (*.cgu) and the method (Original or 
Modified) for calculating LCGU. Once you have selected an accessory file and exited from 
the dialog box, MCID Basic will then prompt you to select a density standards file. Pick the 
[14C] standards file (calibrated in nCi/g) if you have one. Otherwise click [None] to proceed.
03-MW-0117 Imaging Research Inc.
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Figure 4: Select an accessory file and a method for calculating LCGU values.

An LCGU Parameters dialog box appears next (Figure 5), which displays a variety of 
parameters that will be used in solving the operational equation. MCID Basic uses 
appropriate default values for Rate and Lumped constants in the species whose name is 
read from the accessory file. Calculated Values are derived from the data contained within 
the selected accessory file. Note that separate values are given for Gray Matter and White 
Matter.
Changes to any terms in the LCGU equation may be made by entering new values into any 
portion of the solution screen. For example, the lumped constant is sensitive to the plasma 
glucose level and should be modified if hypo- or hyperglycemia is present. Enter any 
relevant changes to the default constants and click [Apply] to re-calculate the parameter. It is 
also possible to skip the accessory file entirely and to type in pre-calculated values for the 
plasma integrals. Please note that any changes made by editing the Rate or Lumped 
constants are temporary. That is, the default values will be used the next time the equation is 
solved.

Figure 5: The LCGU Parameters dialog box.
Imaging Research Inc. 03-MW-0117
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The next step is to calibrate to [14C] concentration standards. In an LCGU experiment, this 
parameter represents the total [14C] trapped in the tissue at the end of the experiment, Ci*. 
The goal of this calibration is to create a curve that relates the system’s internal density 
measurement units (ROD) to the [14C] concentration values (nCi/g). This is achieved by 
entering the concentration values into a calibration table and reading the density of each 
corresponding standard. As each standard is sampled, MCID Basic plots the standard curve 
(density vs. standard value) next to the calibration table. The standard curve should span the 
entire range of densities found in the specimens under study. At least one set of standards 
should be also present on each film. 
The general procedure is as follows:

1. Digitize the standards. Adjust the illumination level so that film background 
appears pinkish-blue with the SPECTRAL.VIS or SPECT2.VIS look-up table. 
This step ensures that you are maximizing the dynamic range of the system.

2. Construct a calibration curve. Enter the [14C] standard values into the calibration 
table and sample the standards.

3. Select a curve fitting function.
4. Select an extrapolation function. This step tells MCID Basic what to do with 

pixels that are outside the range of calibration values.

Building the Calibration Table
Entering the Standard Values

When you click on [OK] to leave the LCGU Parameters dialog box, you asked to select a 
density standards file (i.e., a file containing the [14C] concentrations; see Figure 6). To load a 
file from disk, select the file and click on [OK]. If you want to type the values into the 
calibration table, click on [None]. To create a standards file, click on [Create] (see the 
Advanced Details section for instructions).

Figure 6: The Open Density Standards File dialog box.

The Calibration window now appears as it does in Figure 7. On the left side of the window 
is a table with four columns labeled Std #, Std Value, Value Read, and Rel Error. Just 
03-MW-0117 Imaging Research Inc.



8  Glucose Utilization MCID Basic 7.0
above the table are two entry fields, one for the Standards unit and one for Value read unit. 
To the right of the table is the region where the calibration curves will be plotted as the 
standards are read.
If you are using a density standards file, the standard values are displayed in the Std Value 
column. Otherwise, type the values of the standards into this column and enter the 
appropriate concentration units (nCi/g) into the Standards unit entry field. We recommend 
using a “0” as the lowest concentration standard. When you have entered all of the standard 
values, click the cursor in the Value Read column next to the first standard value.

Note: When entering the standard values, make sure you use ‘tissue equivalent’ values 
and that they are appropriate for the thickness of your tissue sections. The units must be 
in “nCi/g”.

Figure 7: The Calibration window.

Sampling the Standards

Select a pseudocolor look-up table (SPECTRAL.VIS or SPECT2.VIS) and digitize the 
standards. A pseudocolor display makes it easier to see the appropriate light intensity settings 
for background and standards.   It is important to optimize the lighting of your specimen. 
Optimal lighting varies with film density but, ideally, there is a range of less than 1 ROD 
between the darkest and the lightest areas of the film. In this case, blank film would read 
about 0.05 ROD in an 8-bit image (appears pinkish blue in the pseudocolor image), while the 
darkest areas of the autoradiograph read about 0.9 ROD (appear dark red). Do not read from 
film areas that are so light that MCID Basic sees a maximum light value (white). If the film 
background is pink with many white speckles (saturated pixels), turn down the illumination a 
bit.

Note: Small changes in illumination level do not usually require a new Flat Field 
Correction, providing that optical system components are not moved relative to each 
other. 
Imaging Research Inc. 03-MW-0117
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The lightest standard should be a film background reading, entered as a zero concentration in 
the Std Value column. The darkest standard read should lie within a fairly linear region of 
film response. Starting with the lightest standard, sample each one in order of ascending 
concentration. Re-digitize and re-position the standards as needed (do not change the camera 
height). Use the Box sample tool, and adjust its size so that it fits just within the edges of the 
standard. As each standard is sampled, its density value appears in the calibration table in the 
Value Read column, and the entry field automatically shifts to the next position on the list. 
The density calibration curve (ROD vs. nCi/g) is plotted to the right of the calibration table. 
Since [14C] concentration is the only remaining parameter required to solve the operation 
equation, MCID Basic plots the LCGU calibration curve as well (Figure 7). The LCGU 
values (µmol/100g/min) can be plotted as a function of ROD or relative to the standard 
values.

Figure 8: A completed LCGU calibration.

Curve Fitting
Once you have constructed the calibration table, you need to fit a curve to your data points. 
Use the Curve type option to select an interpolation or approximation function that 
calculates density values that lie between the steps provided by the calibration reference 
(Figure 8). 
The graph shows how well a selected fitting function fits the concentration values of the 
reference. A numerical estimate of goodness of fit is available from the Rel Error column in 
the calibration table, where:

Relative Error  =  (standard value - curve value) / standard value
With any good fit, the error proportions will be low (< 0.1).
Experiment with all of the fitting functions and select the one that provides the best fit (e.g., 
where the Rel Error for all points is < 0.1). One of our own favorites is the smoothed spline, 
which offers significant advantages relative to the unsmoothed spline. The unsmoothed 
03-MW-0117 Imaging Research Inc.
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spline is a cube root function that goes through all the points. Because it accommodates to 
standards that do not fit a cube root polynomial, the unsmoothed spline may contain abrupt 
changes in slope. Smoothing the spline allows it to deviate from all of the points, except for 
the lightest density reference (the X,Y origin of the calibration). The smoothed spline is 
forced through the lightest reference.

Figure 9: Interpolation or approximation functions are used to calculate concentration 
values that lie between those contained in the standard set.

Extrapolation Functions
By default, MCID Basic extrapolates calibrated values for pixels that are out of range (i.e., 
that do not fall within the calibration curve). A variety of extrapolation functions are 
available, and they can be applied to either end of the calibration curve. Click on the 
[Extrapolate] button located at the bottom of the calibration curve. This displays the 
Extrapolation dialog box, in which you can either select different forms of extrapolation or 
turn extrapolation off (i.e., clip pixel values to the minimum or maximum standard value).

Figure 10: Density values beyond the range of standard values are estimated by 
extrapolation of the standard curve. You can apply different functions to the maximum and 
minimum ends of the curve.
Imaging Research Inc. 03-MW-0117
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Validity of LCGU Calibrations
Density calibrations are valid only under a narrow range of conditions. ROD values, for 
example, will fluctuate in response to changes in illumination, lens aperture settings, camera 
height, camera settings (gain, offset, exposure time) and even to changes in ambient lighting 
conditions. ROD values will also fluctuate from one sheet of film to the next.
An LCGU calibration is consequently valid under the following conditions:

1. Sections must be from the animal associated with the current accessory file.
2. Sections must be on the same sheet of film as the standards.
3. Sections must be imaged under the same optical conditions that were in effect 

when the calibration curve was established.
Re-calibration is necessary whenever any of these conditions change.

Step 5: Sampling the Specimen
Once you have calibrated ROD to nCi/g, you are ready to gather data from the 
autoradiogram. When you return to the Sample operation window, you will see a column 
labeled “Dens - µmol/100g/min”. To gather data, select a Sample tool and click it on the 
image (see Chapter 4: Collecting Data in the online Reference Manual for complete 
descriptions of Sample tools and instructions for their use).
At the top and to the right of the data table you will see the letters “GM” next to the current 
channel number. This means that MCID Basic is using the Gray Matter constants when it 
calculates µmol/100g/min. from the operational equation. Press the <F11> key to use White 
Matter constants (“WM”). Make sure to use GM constants when sampling from gray matter 
and WM constants when sampling from white matter.
If necessary, use Visuals controls to make features of interest more visible when sampling. 
You can change the way an image looks by selecting a different look-up table (LUT), by 
enhancing contrast, or by changing the LUT mapping function. Although these Visuals 
manipulations change the way an image looks, please remember that none of them change 
the actual density values of the image pixels. See the online Reference Manual for details 
(Chapter 12: Altering Image Appearance).

Calculating the Data Table Value
LCGU data are reported in the data table in calibrated units (µmol/100g/min.). MCID Basic 
calculates the value by first calibrating each pixel contained in the sample and then taking the 
mean of the calibrated pixel values. This is called “integrated optical density”, or IOD:

Integrated Optical Density = Sum of the calibrated pixel values / number of pixels

When Density Data are Displayed in Red

Occasionally, LCGU data may be “flagged” in red. This means that some of the pixels in the 
sample have density values that do not fall within the range of values established for the [14C] 
calibration curve. See the Advanced Details section for more information.
03-MW-0117 Imaging Research Inc.
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Labeling Data
MCID Basic organizes data in a hierarchical fashion as they are gathered:

Subject Animal/subject used in study. 
Section Tissue section from subject. 
Region Anatomical region within tissue section (e.g., “thalamus”, “cortex-left”).
Target Area of an image sampled under a discrete Region label. A target is outlined 

or defined by a Sample tool.
Enter the appropriate Subject, Section and Region labels as you gather data. “Targets” are 
numbered automatically.

TO CREATE LABELS:
1. Click on one of the Subject, Section or Region headings. A label dialog box 

appears on the screen. Each label type has a specific dialog box.
2. Enter the Subject (optional), Section (optional) and Region label in the entry 

field of the relevant dialog box.
3. Sample the region corresponding to this label. 
4. Enter a new Region label and continue until you have all read regions in the 

section.
5. Repeat steps 2 - 4, updating the subject and section labels as required. 
6. Click on the [Done] buttons to close the dialog boxes.

Figure 11: The basic set of labels for managing data from sectioned specimens.

For more information, see Chapter 10: Data Management in the online Reference Manual.

Step 6: Sampling Remaining Animals/Films
Re-calibration is required whenever you gather data from another animal and/or another film. 
Once you have established a new LCGU calibration, MCID Basic will convert the density 
value of each pixel that you subsequently sample to a value that corresponds to the new 
calibration. Data gathered under previous LCGU calibrations are unaffected.

Other Animals
When you are ready to continue the LCGU analysis with another experimental animal (i.e., 
with another accessory file), go to the Calibration operation window and press the [Re-
calibrate] button. Load the appropriate accessory file and MCID Basic will automatically 
generate a new LCGU calibration curve. It is not necessary to establish a new density 
calibration curve (ROD vs. nCi/g) unless the sections are on a different sheet of film (see 
below).
Imaging Research Inc. 03-MW-0117
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Other Film
A set of concentration standards should ideally be present on every sheet of film used in the 
study. To establish a new density calibration (i.e., ROD vs. nCi/g), go to the Calibration 
operation window and update the Value Read values in the calibration table accordingly. To 
update these values, place the cursor in the first Value Read field and repeat the procedure 
described in Sampling the Standards, above. As each standard is read, MCID Basic also 
updates the LCGU calibration curve accordingly. If necessary, select a new curve fitting 
function as well.

Step 7: Summarizing and Saving Data
MCID Basic contains a number of sophisticated data tracking, reporting and management 
facilities. If you label your targets as you gather data, you can create a variety of different 
data display formats that allow you to summarize data across and/or within Subjects, 
Sections and/or Regions. The MCID Basic imaging system’s data tracking capabilities can 
even show you where a given number comes from in an image. You can save data to disk as 
a proprietary, binary “log” file (*.lg2), or as standard text or spreadsheet files.
It is beyond the scope of this Application Guide to present all MCID Basic data management 
features. A few particularly useful summary configuration and saving options are presented 
below, however. For a complete description, see the online Reference Manual (see Chapter 
10: Data Management).

Summary Data Displays
Two sets of controls are used to create data summaries. The first is a set of radio buttons 
underneath the Subject, Section and Region label indicators (press the button if they 
are not visible):

The second is a list of four data Summary Tables located in the Table toolbar (View > Table 
bar):

All Targets

The Target Table is the most detailed form of data display, as it shows a discrete line of data 
for each individual target. By default, the MCID Basic data table lists only the data from the 
Current Subject, Current Section, and Current Region. To view all of the data you have 
gathered in one table, change the radio buttons to All Subjects, All Sections, All Regions. 
Every sample is subsequently displayed by its Subject, Section, Region and Target label 
(Figure 8).
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Figure 12: Part of a Target Table display showing data gathered from All Subjects, All 
Sections and All Regions.

Subject x Region Summary Table

Autoradiography data is frequently exported into statistics packages for analysis by Analysis 
of Variance. The preferred summary format is consequently a table that displays data from 
each individual subject by each individual anatomical region.
You can display data in tabular format, with Subjects as rows, Regions as columns. To see 
the Subject x Region view, select the Subject x Region summary table: 

To pool data across all sections, select the All sections: Summary radio button. To display 
data within each section, select All sections: Detail.
Please note that MCID Basic can only display one measure at a time in this summary format. 
MCID Basic displays the current measure above the Subject label indicator on the left side 
of the data table. If you have made more than one type of measurement, double-click in this 
field to scroll to another measure (see Figure 13).

Figure 13: A Subject x Region data summary. Notice the Subject labels arranged in rows, 
Regions labels as columns. MCID Basic can display one measure at time in this format.

Saving Data
MCID Basic stores data in a proprietary, binary “log” file format (*.lg2). Log files contain 
more than just numerical data. They contain data, label lists, channel tracking information, 
and the calibration that was in effect when the file was saved. You can also save target 
outlines in log files. 
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TO CREATE A LOG FILE:
1. Go to the Sample window and open the File menu.
2. Select the Save as option. The Save Data File dialog box appears (Figure 14).
3. Type a filename into the entry field (e.g., Experiment 1). There is no need to type 

a file extension; MCID Basic always attaches the appropriate extension whenever 
it saves a file.

4. Press the [Save] button. MCID Basic stores the file to disk under the specified 
filename.

Figure 14: The Save Data File dialog box.

Re-Opening a Log File

When you open a log file (File > Open), MCID Basic loads its data, labels (Subject, Section, 
Region), and the last density calibration. This is almost like going back to the analysis 
session when you created the file. You can edit data within the log file, create different data 
summary configurations, and add new data if you wish. 

Note: The calibration contained in the log file is the one that was in effect when you last 
saved the log file. MCID Basic saves calibrated data, but only the most recent 
calibration. If you intend to continue sampling, we recommend you establish new 
calibrations.

Saving Target Outlines

To save target outlines with the log file, check the Target shape option in the Save Data File 
dialog box. With target outlines saved, you can click on any numerical value and see the 
target outline from which it came.
Please note that target outlines are linked to channel coordinates, not to specific images. For 
this feature to be useful (i.e., to be able to re-display the target outline on the image from 
which it came), you have to be able to display both the sample window and the image 
associated with each numerical value. Images should consequently be saved to disk after they 
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have been sampled. We recommend using the Subject and Section label entries as image 
filenames for easy indexing. You want to be able to identify the image associated with each 
numerical data point.
To see the origin of a data point, retrieve the log file that contains it. Now load the image file 
that contains the data point that you wish to check. When you click on the data point, the 
sample window saved with it appears on the image. 

Exporting Data

The MCID Basic log file format (*.lg2) cannot be read by other programs. To format data 
for use with other software (e.g., word processing, spreadsheet, database programs), select 
the File > Export command. A variety of text file formats are available, including tab 
delimited (*.txt), comma delimited (*.csv) and space delimited (*.prn). Lotus® 1-2-3 
(*.wks) and Microsoft® Excel Workbook (*.xls) files can also be created. Please note, to 
create *xls files from your data, Excel must be installed on the MCID Basic computer.
File  > Export uses the WYSIWYG (what you see is what you get) principle. Only the data 
in the current display will be exported, just as it appears on your monitor. You should 
consequently select all the data display options (e.g., within and across Regions, Sections, 
Subjects), and the summary options (e.g., Region or Target Summary table) before 
exporting your data. 

Advanced Details
Creating Standards Files
Most laboratories use a limited number of standard sets as external references.   To avoid 
repetitive typing, you can save the values for each set and retrieve them when you need to 
calibrate. To create a standards file, either click on the [Create] button in the Open Density 
Standards File dialog box (Figure 6) or open the Calibrations menu and select Edit 
accessory file > Calibration standards. This calls up a dialog box into which you can type 
the values of your [14C] standards, one per line (Figure 15). Enter the standards unit (e.g., 
fmol/mg) in the Standards unit entry field. Then open the File menu in the dialog box and 
save the file. The file is saved with an *.std extension. 

Note: This dialog box has no scroll bars. Use the arrow keys to navigate up and down the 
list of standard values.
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Figure 15: Creating a file containing the values of external density standards.

Background Subtraction

For Density calibrations, you can use an unexposed part of the film or plate area as the 
background standard. This represents zero concentration, but the density standards also 
contain this background value and calibration should take care of the background 
contribution to standard values.
If you prefer, MCID Basic can subtract a background value from each standard before 
calibration. This procedure can reduce the relative error at the lower end of the calibration 
curve when weighted regression curves are used (i.e., 1/read, 1/read2). To use this feature, 
click on the Include background subtraction checkbox.
If Include background subtraction is enabled, a Bkgd term is added to the list of standard 
values when you open the standards file. Sample an unexposed part of the film as the Bkgd 
standard. When the calibration curve is constructed, this background density value is 
subtracted from the Value Read for each standard. The resulting values are used to derive 
the parameters used for 1/read and 1/read2 weighted regression curve types. 

When Density Data are Displayed in Red
Occasionally, calibrated density data may be “flagged” in red. This means that some of the 
pixels in the sample have density values that do not fall within the range of values established 
for the calibration curve. Treat such data with caution. Your decision to accept or reject the 
data should depend on a) how many pixels are out of range, b) how far out of range they are, 
and c) what you’ve told MCID Basic to do with pixels that are out of range.
To find out how many pixels are out of range, open the Sample menu and select Advanced > 
Density limits. The Density Limit Calculation dialog box controls the display of data that is 
out of calibrated range. Select the Report % checkbox and MCID Basic will report the 
proportion of out-of-range pixels in the sample. The proportion is displayed in the data table, 
next to the flagged data.
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Figure 16: The Density Limit Calculation dialog box controls the display of data from 
samples that contain pixels that are out of range. Such data is displayed in red.

By default, MCID Basic will flag data when 1% or more of its pixels are out of calibrated 
range. If you are willing to accept a higher percentage of out-of-range pixels in your samples, 
enter a higher Flag threshold. For example, if you are willing to accept data from a sample 
with less than ten percent of its pixels out of range, enter a “10” in the Flag threshold entry 
field. MCID Basic will then only flag data when 10% or more its pixels are out of range.
By default, MCID Basic extrapolates calibrated values for pixels that are out of range. A 
variety of extrapolation functions are available, and they can be applied to either end of the 
calibration curve. Alternatively, MCID Basic can “clip” out-of-range pixels to the maximum 
or minimum standard value. For access to extrapolation options, go to the Calibration 
window and press the [Extrapolate] button displayed beneath the density calibration curve.
Regardless of whether you choose to extrapolate or clip pixels that are out of range, be 
advised that these operations are meant to correct for minor excursions beyond the calibration 
curve. They should not be used as a correction for poor exposures. 
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